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Chapter 1  
Introduction 

This manual describes the details of the shear wall design and stress check 
algorithms used by the program when the user selects the ACI 318-14 design 
code. The various notations used in this manual are described in Section 1.1. 

The design is based on loading combinations specified by the user (Section 
1.2). To facilitate the design process, the program provides a set of default load 
combinations that should satisfy requirements for the design of most building 
type structures.  

The program performs the following design, check, or analysis procedures in 
accordance with ACI 318-14 and IBC 2012 requirements:  

 Design and check of concrete wall piers for flexural and axial loads (Chapter 
2) 

 Design of concrete wall piers for shear (Chapter 2) 

 Consideration of the boundary element requirements for concrete wall piers 
using an approach based on the requirements of the code (Chapter 2) 

 Design of concrete shear wall spandrels for flexure (Chapter 3) 

 Design of concrete wall spandrels for shear (Chapter 3) 
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The program provides detailed output data for Simplified pier section design, 
Uniform pier section design/check, and Section Designer pier section 
design/check (Chapter 4). 

1.1. Notation  
Following is the notation used in this manual. 

Acv Net area of a wall pier bounded by the length of the wall pier, 
Lp, and the web thickness, tp, in2 

Ag Gross area of a wall pier, in2 

Ah-min Minimum required area of distributed horizontal reinforcing 
steel required for shear in a wall spandrel, in2/inch 

As Area of reinforcing steel, in2 

Asc Area of reinforcing steel required for compression in a pier 
edge member, or the required area of tension steel required to 
balance the compression steel force in a wall spandrel, in2 

Asc-max Maximum area of compression reinforcing steel in a wall pier 
edge member, in2 

Asf The required area of tension reinforcing steel for balancing the 
concrete compression force in the extruding portion of the 
concrete flange of a T-beam, in2 

Ast Area of reinforcing steel required for tension in a pier edge 
member, in2 

Ast-max Maximum area of tension reinforcing steel in a wall pier edge 
member, in2 

Av Area of reinforcing steel required for shear, in2 / in 

Avd Area of diagonal shear reinforcement in a coupling beam, in2 

1-2 Notation 
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Av-min Minimum required area of distributed vertical reinforcing steel 
required for shear in a wall spandrel, in2 / in 

Asw The required area of tension reinforcing steel for balancing the 
concrete compression force in a rectangular concrete beam, or 
for balancing the concrete compression force in the concrete 
web of a T-beam, in2 

A's Area of compression reinforcing steel in a spandrel, in2 

B1, B2... Length of a concrete edge member in a wall with uniform 
thickness, in 

Cc Concrete compression force in a wall pier or spandrel, lbs 

Cf Concrete compression force in the extruding portion of a T-
beam flange, lbs 

Cs Compression force in wall pier or spandrel reinforcing steel, lbs 

Cw Concrete compression force in the web of a T-beam, lbs 

D/C Demand/Capacity ratio as measured on an interaction curve for 
a wall pier, unitless 

DB1 Length of a user-defined wall pier edge member, in. This can 
be different on the left and right sides of the pier, and it also 
can be different at the top and the bottom of the pier.  

DB2 Width of a user-defined wall pier edge member, in. This can be 
different on the left and right sides of the pier, and it also can 
be different at the top and the bottom of the pier. 

Es Modulus of elasticity of reinforcing steel, psi 

IP-max The maximum ratio of reinforcing considered in the design of a 
pier with a Section Designer section, unitless 

IP-min The minimum ratio of reinforcing considered in the design of a 
pier with a Section Designer section, unitless 
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LBZ Horizontal length of the boundary zone at each end of a wall 
pier, in 

Lp Horizontal length of wall pier leg, in. This can be different at 
the top and the bottom of the pier 

Ls Horizontal length of wall spandrel, in 

LL Live load 

Mn Nominal bending strength, lb-in 

Mu Factored bending moment at a design section, lb-in 

Muc In a wall spandrel with compression reinforcing, the factored 
bending moment at a design section resisted by the couple 
between the concrete in compression and the tension steel, lb-in 

Muf In a wall spandrel with a T-beam section and compression 
reinforcing, the factored bending moment at a design section 
resisted by the couple between the concrete in compression in 
the extruding portion of the flange and the tension steel, lb-in 

Mus In a wall spandrel with compression reinforcing, the factored 
bending moment at a design section resisted by the couple be-
tween the compression steel and the tension steel, lb-in 

Muw In a wall spandrel with a T-beam section and compression 
reinforcing, the factored bending moment at a design section 
resisted by the couple between the concrete in compression in 
the web and the tension steel, lb-in 

OC On a wall pier interaction curve the distance from the origin to 
the capacity associated with the point considered, in 

OL On a wall pier interaction curve the distance from the origin to 
the point considered, in 

Pb The axial force in a wall pier at a balanced strain condition, lbs 

1-4 Notation 
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Pleft Equivalent axial force in the left edge member of a wall pier 
used for design, lbs. This may be different at the top and the 
bottom of the wall pier. 

Pmax Limit on the maximum compressive design strength specified 
by the code, lbs 

Pmax Factor Factor used to reduce the allowable maximum compressive 
design strength, unitless. The code specifies this factor to be 
0.80. This factor can be revised in the preferences. 

Pn Nominal axial strength, lbs 

Po Nominal axial load strength of a wall pier, lbs 

Poc The maximum compression force a wall pier can carry with 
strength reduction factors set equal to one, lbs 

Pot The maximum tension force a wall pier can carry with strength 
reduction factors set equal to one, lbs 

Pright Equivalent axial force in the right edge member of a wall pier 
used for design, lbs. This may be different at the top and the 
bottom of the wall pier. 

Pu Factored axial force at a design section, lbs 

PCmax Maximum ratio of compression steel in an edge member of a 
wall pier, unitless 

PTmax Maximum ratio of tension steel in an edge member of a wall 
pier, unitless 

RLL Reduced live load 

Ts Tension force in wall pier reinforcing steel, lbs 

Vc The portion of the shear force carried by the concrete, lbs 

Vn Nominal shear strength, lbs 
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Vs The portion of the shear force in a spandrel carried by the shear 
reinforcing steel, lbs 

Vu Factored shear force at a design section, lbs 

WL Wind load 

a Depth of the wall pier or spandrel compression block, in 

a1 Depth of the compression block in the web of a T-beam, in 

bs Width of the compression flange in a T-beam, in. This can be 
different on the left and right ends of the T-beam. 

c Distance from the extreme compression fiber of the wall pier or 
spandrel to the neutral axis, in 

dr-bot Distance from the bottom of the spandrel beam to the centroid 
of the bottom reinforcing steel, in. This can be different on the 
left and right ends of the beam. 

dr-top Distance from the top of the spandrel beam to the centroid of 
the top reinforcing steel, in. This can be different on the left and 
right ends of the beam. 

ds Depth of the compression flange in a T-beam, in. This can be 
different on the left and right ends of the T-beam. 

dspandrel Depth of the spandrel beam minus the cover to the centroid of 
the reinforcing, in 

fy Yield strength of steel reinforcing, psi. This value is used for 
flexural and axial design calculations. 

fys Yield strength of steel reinforcing, psi. This value is used for 
shear design calculations. 

f 'c Concrete compressive strength, psi. This value is used for flex-
ural and axial design calculations. 

1-6 Notation 
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f 'cs Concrete compressive strength, psi. This value is used for shear 
design calculations. 

f's Stress in compression steel of a wall spandrel, psi. 

hs Height of a wall spandrel, in. This can be different on the left 
and right ends of the spandrel. 

pmax Maximum ratio of reinforcing steel in a wall pier with a Section 
Designer section that is designed (not checked), unitless. 

pmin Minimum ratio of reinforcing steel in a wall pier with a Section 
Designer section that is designed (not checked), unitless. 

tp Thickness of a wall pier, in. This can be different at the top and 
bottom of the pier. 

ts Thickness of a wall spandrel, in. This can be different on the 
left and right ends of the spandrel. 

ΣDL The sum of all dead load cases 

ΣLL The sum of all live load cases 

ΣRLL The sum of all reduced live load cases 

α The angle between the diagonal reinforcing and the longitudi-
nal axis of a coupling beam 

β1 Unitless factor defined in Section 22.2.2.4.3 of the code 

ε Reinforcing steel strain, unitless 

εs Reinforcing steel strain in a wall pier, unitless 

ε's Compression steel strain in a wall spandrel, unitless 

φ Strength reduction factor, unitless 

φt Strength reduction factor for bending and tension controlled 
cases, unitless. The default value is 0.9. 
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φc Strength reduction factor for bending plus high axial compres-
sion in a concrete pier, unitless. The default value is 0.65. 

φvns Strength reduction factor for shear in a nonseismic pier or 
spandrel, unitless. The default value is 0.75. 

φvs Strength reduction factor for shear in a seismic pier or spandrel, 
unitless. The default value is 0.6. 

λ Modification factor reflecting the reduced mechanical pro-
perties of light-weight concrete, all relative to normal weight 
concrete of the same compressive strength. It is equal to 1 for 
normal weight concrete. 

σs Reinforcing steel stress in a wall pier, psi 

1.2. Design Station Locations 
The program designs wall piers at stations located at the top and bottom of the 
pier only. To design at the mid-height of a pier, break the pier into two separate 
"half-height" piers. 

The program designs wall spandrels at stations located at the left and right ends 
of the spandrel only. To design at the mid-length of a spandrel, break the span-
drel into two separate "half-length" spandrels. Note that if a spandrel is broken 
into pieces, the program will calculate the seismic diagonal shear reinforcing 
separately for each piece. The angle used to calculate the seismic diagonal 
shear reinforcing for each piece is based on the length of the piece, not the 
length of the entire spandrel. This can cause the required area of diagonal rein-
forcing to be significantly underestimated. Thus, if a spandrel is broken into 
pieces, calculate the seismic diagonal shear reinforcing separately by hand. 

1.3. Default Design Load Combinations 
The design load combinations automatically created by the program for con-
crete shear wall design are given by the following equations (ACI 9.2.1). 
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1.4D  (ACI 5.3.1a)   

1.2D + 1.6L + 0.5Lr (ACI 5.3.1b)   
1.2D + 1.0L + 1.6Lr (ACI 5.3.1c)   

1.2D + 1.6(0.75 PL) + 0.5Lr (ACI 5.3.1b, 6.4.3.3)   
1.2D + 1.6L + 0.5S (ACI 5.3.1b)   
1.2D + 1.0L + 1.6S (ACI 5.3.1c)   

0.9D ± 1.0W (ACI 5.3.1f) 
1.2D + 1.0L + 0.5Lr ± 1.0W (ACI 5.3.1d) 
1.2D + 1.6Lr ± 0.5W (ACI 5.3.1c) 

 
1.2D + 1.6S ± 0.5W (ACI 5.3.1c) 
1.2D + 1.0L + 0.5S ± 1.0W (ACI 5.3.1d) 

0.9D ± 1.0E  
1.2D + 1.0L + 0.2S ± 1.0E  

(ACI 5.3.1g) 
(ACI 5.3.1e)   

 
In the preceding Equations, 

D = The sum of all dead load  load cases defined for the model. 

L = The sum of all live load  load cases defined for the model. Note 
that this includes roof live loads as well as floor live loads. 

Lr = The sum of all roof live load  load cases defined for the model. 

S = The sum of all snow load  load cases defined for the model. 

W = Any single wind load load case defined for the model. 

E = Any single earthquake load load case defined for the model. 

1.3.1. 6BDead Load Component 
The dead load component of the default design load combinations consists of 
the sum of all dead loads multiplied by the specified factor. Individual dead 
load cases are not considered separately in the default design load combina-
tions. 
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See the description of the earthquake load component later in this chapter for 
additional information. 

1.3.2. 7BLive Load Component 
The live load component of the default design load combinations consists of 
the sum of all live loads, both reducible and unreducible, multiplied by the 
specified factor. Individual live load cases are not considered separately in the 
default design load combinations. 

1.3.3. Roof Live Load Component 
The live load component of the default design load combinations consists of 
the sum of all roof live loads (unreducible), multiplied by the specified factor. 

1.3.4. 7BSnow Load Component 
The snow load component of the default design load combinations consists of 
the sum of all snow loads, multiplied by the specified factor. Individual live 
load cases are not considered separately in the default design load combina-
tions. 

1.3.5. 8BWind Load Component 
The wind load component of the default design load combinations consists of 
the contribution from a single wind load case. Thus, if multiple wind load cases 
are defined in the program model, each of ACI Equations 5.3.1c, 5.3.1d and 
5.3.1f will contribute multiple design load combinations, one for each wind 
load case that is defined. 

1.3.6. 9BEarthquake Load Component 
The earthquake load component of the default design load combinations con-
sists of the contribution from a single earthquake load case. Thus, if multiple 
earthquake load cases are defined in the program model, each of ACI Equa-
tions 5.3.1e and 5.3.1g will contribute multiple design load combinations, one 
for each earthquake load case that is defined. 

1-10 Default Design Load Combinations 
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The earthquake load cases considered when creating the default design load 
combinations include all static load cases that are defined as earthquake loads 
and all response spectrum cases. Default design load combinations are not cre-
ated for time history cases or for static nonlinear cases. 

1.3.7. 10BCombinations that Include a Response Spectrum 
In the program all response spectrum cases are assumed to be earthquake load 
cases. Default design load combinations are created that include the response 
spectrum cases. 

The output from a response spectrum is all positive. Any design load 
combination that includes a response spectrum load case is checked for all 
possible combinations of signs on the response spectrum values. Thus, when 
checking shear in a wall pier or a wall spandrel, the response spectrum 
contribution of shear to the design load combination is considered once as a 
positive shear and then a second time as a negative shear. Similarly, when 
checking moment in a wall spandrel, the response spectrum contribution of 
moment to the design load combination is considered once as a positive 
moment and then a second time as a negative moment. When checking the 
flexural behavior of a two-dimensional wall pier or spandrel, four possible 
combinations are considered for the contribution of response spectrum load to 
the design load combination. They are: 

 +P and +M 

 +P and −M 

 −P and +M 

 −P and −M 

where P is the axial load in the pier and M is the moment in the pier. Similarly, 
eight possible combinations of P, M2 and M3 are considered for three-
dimensional wall piers. 

Note that based on the above, ACI Equation 5.3.1e with negative sign for 
earthquake is redundant for a load combination with a response spectrum, and 
similarly, ACI Equation 5.3.1g with negative sign for earthquake is redundant 
for a load combination with a response spectrum. For this reason, the program 
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creates default design load combinations based on ACI Equations 5.3.1e and 
5.3.1g with only positive sign for earthquake for response spectra. Default de-
sign load combinations using ACI Equations 5.3.1e and 5.3.1g with negative 
sign for earthquake are not created for response spectra. 

1.3.8. 11BCombinations that Include Time History Results 
The default shear wall design load combinations do not include any time histo-
ry results. Therefore, user-defined load combinations should include time histo-
ry forces. 

When a design load combination includes time history results, the design can 
be for the envelope of those results or for each step of the time history. The 
type of time history design can be specified in the shear wall design prefer-
ences (Appendix A).  

When envelopes are used, the design is for the maximum of each response 
quantity (axial load, moment, and the like) as if they occurred simultaneously. 
Typically, this is not the realistic case, and in some instances, it may be uncon-
servative. Designing for each step of a time history gives the correct corre-
spondence between different response quantities, but designing for each step 
can be very time consuming. 

When the program gets the envelope results for a time history, it gets a maxi-
mum and a minimum value for each response quantity. Thus, for wall piers it 
gets maximum and minimum values of axial load, shear and moment; and for 
wall spandrels, it gets maximum and minimum values of shear and moment.  
For a design load combination in the program shear wall design module, any 
load combination that includes a time history load case in it is checked for all 
possible combinations of maximum and minimum time history design values. 
Thus, when checking shear in a wall pier or a wall spandrel, the time history 
contribution of shear to the design load combination is considered once as a 
maximum shear and then a second time as a minimum shear. Similarly, when 
checking moment in a wall spandrel, the time history contribution of moment 
to the design load combination is considered once as a maximum moment and 
then a second time as a minimum moment. When checking the flexural behav-
ior of a wall pier, four possible combinations are considered for the contribu-
tion of time history load to the design load combination. They are: 
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 Pmax and Mmax 

 Pmax and Mmin 

 Pmin and Mmax 

 Pmin and Mmin 

where P is the axial load in the pier and M is the moment in the pier. 

If a single design load combination has more than one time history case in it, 
that design load combination is designed for the envelopes of the time histo-
ries, regardless of what is specified for the Time History Design item in the 
preferences. 

1.3.9. 12BCombinations that Include Static Nonlinear Results 
The default shear wall design load combinations do not include any static non-
linear results. Therefore, user-defined load combinations should include static 
nonlinear results. 

If a design load combination includes a single static nonlinear case and nothing 
else, the design is performed for each step of the static nonlinear analysis. Oth-
erwise, the design is only performed for the last step of the static nonlinear 
analysis. 

1.4. Shear Wall Design Preferences 
The shear wall design preferences are basic properties that apply to all wall pier 
and spandrel elements. Appendix A identifies shear wall design preferences for 
the code.  

Default values are provided for all shear wall design preference items. Thus, it 
is not required that preferences be specified. However, at least review the de-
fault values for the preference items to make sure they are acceptable. 
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1.5. Shear Wall Design Overwrites 
The shear wall design overwrites are basic assignments that apply only to those 
piers or spandrels to which they are assigned. The overwrites for piers and 
spandrels are separate. Appendix B identifies the shear wall overwrites for the 
code. Note that the available overwrites change depending on the pier section 
type (Uniform Reinforcing, General Reinforcing, or Simplified C and T).   

Default values are provided for all pier and spandrel overwrite items. Thus, it is 
not necessary to specify or change any of the overwrites. However, at least 
review the default values for the overwrite items to make sure they are 
acceptable. When changes are made to overwrite items, the program applies 
the changes only to the elements to which they are specifically assigned, that 
is, to the elements that are selected when the overwrites are changed. 

1.6. Choice of Units 
For shear wall design in this program, any set of consistent units can be used 
for input. Also, the system of units being used can be changed at any time. 
Typically, design codes are based on one specific set of units.  

The code is based on Pound-Inch-Second units. For simplicity, all equations 
and descriptions presented in this manual correspond to pound-inch-second 
units unless otherwise noted.  

The Display Unit preferences allow the user to specify special units for concen-
trated and distributed areas of reinforcing. The special units specified for con-
centrated and distributed areas of reinforcing can be changed anytime. 

The choices available in the Display Units preferences for the units associated 
with an area of concentrated reinforcing are in2, cm2, mm2, ft2 and m2. The 
choices available for the units associated with an area per unit length of distrib-
uted reinforcing are in2/ft, cm2/m, mm2/m, in2/in, cm2/cm, and so on. 
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Chapter 2 
Pier Design 

This chapter describes how the program designs and checks concrete wall piers 
for flexural and axial loads when the ACI 318-14 option is selected. First we 
describe how the program designs piers that are specified by a Simplified C & 
T Section. Next we describe how the program checks piers that are specified by 
a Uniform Reinforcing Pier Section or General Section (i.e., Section Designer). 
Then we describe how the program designs piers that are specified by a 
Uniform Reinforcing Pier Section or General Section (Section Designer). 

This chapter also describes how the program designs each leg of concrete wall 
piers for shear when the ACI 318-14 option is selected. Note that in this 
program the user cannot specify shear reinforcing and then have the program 
check it. The program only designs the pier for shear and reports how much 
shear reinforcing is required. The shear design is performed at stations at the 
top and bottom of the pier. 

This chapter also describes the design of boundary zone elements for each pier 
in accordance with ACI Section 18.10.6 when a seismic load case is present in 
wall design load combinations.  

 2-1 
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2.1 Wall Pier Flexural Design 
For both designing and checking piers, it is important to understand the local 
axis definition for the pier. Access the local axes assignments using the Assign 
menu. 

2.1.1 Designing a Simplified C & T Pier Section 
This section describes how the program designs a pier that is assigned a 
simplified section. The geometry associated with the simplified section is 
illustrated in Figure 2-1. The pier geometry is defined by a length, thickness, 
and size of the edge members at each end of the pier (if any).  

 

Figure 2-1: Typical Wall Pier Dimensions Used for Simplified Design 

A simplified T and C pier section is always planar (not three-dimensional). The 
dimensions shown in the figure include the following: 

2-2 Wall Pier Flexural Design 
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 The length of the wall pier is designated Lp. This is the horizontal length of 
the wall pier in plan. 

 The thickness of the wall pier is designated tp. The thickness specified for 
left and right edge members (DB2left and DB2right) may be different from 
this wall thickness. 

 DB1 represents the horizontal length of the pier edge member. DB1 can be 
different at the left and right sides of the pier. 

 DB2 represents the horizontal width (or thickness) of the pier edge 
member. DB2 can be different at the left and right sides of the pier. 

The dimensions illustrated are specified in the shear wall overwrites (Appendix 
B), and can be specified differently at the top and bottom of the wall pier. 

If no specific edge member dimensions have been specified by the user, the 
program assumes that the edge member thickness is the same as the thickness 
of the wall, and the program determines the required length of the edge 
member. In all cases, whether the edge member size is user-specified or 
program-determined, the program reports the required area of reinforcing steel 
at the center of the edge member. This section describes how the program-
determined length of the edge member is determined and how the program 
calculates the required reinforcing at the center of the edge member. 

Three design conditions are possible for a simplified wall pier. These 
conditions, illustrated in Figure 2-2, are as follows: 

 The wall pier has program-determined (variable length and fixed width) edge 
members on each end. 

 The wall pier has user-defined (fixed length and width) edge members on 
each end. 

 The wall pier has a program-determined (variable length and fixed width) 
edge member on one end and a user-defined (fixed length and width) edge 
member on the other end. 
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Design Condition 2
Wall pier with user-defined edge
members

Design Condition 1
Wall pier with uniform thickness and
ETABS-determined (variable length)
edge members

Design Condition 3
Wall pier with a user-defined edge
member on one end and an ETABS-
determined (variable length) edge
member on the other end

Note:
In all three conditions, the only
reinforcing designed by ETABS is that
required at the center of the edge
members  

Figure 2-2: Design Conditions for Simplified Wall Piers 

2.1.1.1 Design Condition 1 
Design condition 1 applies to a wall pier with uniform design thickness and 
program-determined edge member length. For this design condition, the design 
algorithm focuses on determining the required size (length) of the edge mem-
bers, while limiting the compression and tension reinforcing located at the 
center of the edge members to user-specified maximum ratios. The maximum 
ratios are specified in the shear wall design preferences and the pier design 
overwrites as Edge Design PC-Max and Edge Design PT-Max. 

Consider the wall pier shown in Figure 2-3. For a given design section, say the 
top of the wall pier, the wall pier for a given design load combination is 
designed for a factored axial force Pu-top and a factored moment Mu-top.  

The program initiates the design procedure by assuming an edge member at the 
left end of the wall of thickness tp and width B1-left, and an edge member at the 
right end of the wall of thickness tp and width B1-right. Initially B1-left = B1-right = 
tp. 

The moment and axial force are converted to an equivalent force set Pleft-top and 
Pright-top using the relationships shown in the following equations. (Similar 
equations apply to the bottom of the pier.) 
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Figure 2-3: Wall Pier for Design Condition 1 
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For any given loading combination, the net values for Pleft-top and Pright-top could 
be tension or compression. 

Note that for dynamic loads, Pleft-top and Pright-top are obtained at the modal level 
and the modal combinations are made, before combining with other loads. Also 
for design loading combinations involving SRSS, the Pleft-top and Pright-top forces 
are obtained first for each load case before the combinations are made. 

If any value of Pleft-top or Pright-top is tension, the area of steel required for 
tension, Ast, is calculated as: 

 st
t y

PA
f

=
φ

. 

If any value of Pleft-top or Pright-top is compression, for section adequacy, the area 
of steel required for compression, Asc, must satisfy the following relationship. 

 ( ) '
max Factor( ) [0.85 ( ) ]c c g sc y scAbs P P f A A f A= φ − +  (ACI Table 22.4.2.1) 

where P is either Pleft-top or Pright-top, Ag = tpB1 and the Pmax Factor  is defined in the 
shear wall design preferences (the default is 0.80). In general, we recommend 
the use of the default value. From the preceding equation, 

 

'

max Factor
'

( ) 0.85
( )

0.85

c g
c

sc
y c

Abs P f A
P

A
f f

−
ϕ

=
−
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If Asc calculates as negative, no compression reinforcing is needed. 

The maximum tensile reinforcing to be packed within the tp times B1 concrete 
edge member is limited by: 

 -max max 1.st pA PT t B=  
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Similarly, the compression reinforcing is limited by: 

 -max max 1.sc pA PC t B=  

If Ast is less than or equal to Ast-max and Asc is less than or equal to Asc-max, the 
program will proceed to check the next loading combination; otherwise the 
program will increment the appropriate B1 dimension (left, right or both, 
depending on which edge member is inadequate) by one-half of the wall 
thickness to B2 (i.e., 1.5tp) and calculate new values for Pleft-top and Pright-top 
resulting in new values of Ast and Asc. This iterative procedure continues until 
Ast and Asc are within the allowed steel ratios for all design load combinations. 

If the value of the width of the edge member B increments to where it reaches a 
value larger than or equal to Lp /2, the iteration is terminated and a failure 
condition is reported. 

This design algorithm is an approximate but convenient algorithm. Wall piers 
that are declared overstressed using this algorithm could be found to be 
adequate if the reinforcing steel is user-specified and the wall pier is accurately 
evaluated using interaction diagrams. 

2.1.1.2 Design Condition 2 
Design condition 2 applies to a wall pier with user-specified edge members at 
each end of the pier. The size of the edge members is assumed to be fixed; that 
is, the program does not modify them. For this design condition, the design 
algorithm determines the area of steel required in the center of the edge 
members and checks if that area gives reinforcing ratios less than the user-
specified maxi-mum ratios. The design algorithm used is the same as described 
for condition 1; however, no iteration is required. 

2.1.1.3 Design Condition 3 
Design condition 3 applies to a wall pier with a user-specified (fixed 
dimension) edge member at one end of the pier and a variable length (program-
determined) edge member at the other end. The width of the variable length 
edge member is equal to the width of the wall.  
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The design is similar to that which has previously been described for design 
conditions 1 and 2. The size of the user-specified edge member is not changed. 
Iteration only occurs on the size of the variable length edge member. 

2.1.2 Checking a General or Uniform Reinforcing Pier Section 
When a General Reinforcing or Uniform Reinforcing pier section is specified 
to be checked, the program creates an interaction surface for that pier and uses 
that interaction surface to determine the critical flexural demand/capacity ratio 
for the pier. This section describes how the program generates the interaction 
surface for the pier and how it determines the demand/capacity ratio for a given 
design load combination. 

Note:  In this program, the interaction surface is defined by a series of PMM interac-
tion curves that are equally spaced around a 360-degree circle. 

2.1.2.1 Interaction Surface 
In this program, a three-dimensional interaction surface is defined with 
reference to the P, M2 and M3 axes. The surface is developed using a series of  
interaction curves that are created by rotating the direction of the pier neutral 
axis in equally spaced increments around a 360-degree circle. For example, if 
24 PMM curves are specified (the default), there is one curve every 15 degrees 
(360°/24 curves = 15°). Figure 2-4 illustrates the assumed orientation of the 
pier neutral axis and the associated sides of the neutral axis where the section is 
in tension (designated T in the figure) or compression (designated C in the 
figure) for various angles. 

Note that the orientation of the neutral axis is the same for an angle of θ and 
θ+180°. Only the side of the neutral axis where the section is in tension or 
compression changes. We recommend that 24 interaction curves (or more) be 
used to define a three-dimensional interaction surface. 

Each PMM interaction curve that makes up the interaction surface is 
numerically described by a series of discrete points connected by straight lines. 
The coordinates of these points are determined by rotating a plane of linear 
strain about the neutral axis on the section of the pier. Details of this process 
are described later in the section entitled "Details of the Strain Compatibility 
Analysis." 
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a) Angle is 0 degrees 45°
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Figure 2-4: Orientation of the Pier Neutral Axis for Various Angles 

By default, 11 points are used to define a PMM interaction curve. This number 
can be changed in the preferences; any odd number of points greater than or 
equal to 11 can be specified, to be used in creating the interaction curve. If an 
even number is specified for this item in the preferences, the program will 
increment up to the next higher odd number. 

Note that when creating an interaction surface for a two-dimensional wall pier, 
the program considers only two interaction curvesthe 0° curve and the 180° 
curveregardless of the number of curves specified in the preferences. 
Furthermore, only moments about the M3 axis are considered for two-
dimensional walls. 

2.1.2.2 Formulation of the Interaction Surface 
The formulation of the interaction surface in this program is based consistently 
on the basic principles of ultimate strength design (ACI 22.2). The program 
uses the requirements of force equilibrium and strain compatibility to 
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determine the nominal axial and moment strength (Pn, M2n, M3n) of the wall 
pier. This nominal strength is then multiplied by the appropriate strength 
reduction factor, φ, to obtain the design strength (φPn, φM2n, φM3n) of the pier. 
For the pier to be deemed adequate, the required strength (Pu, M2u, M3u) must 
be less than or equal to the design strength. 

 (Pu, M2u, M3u) ≤ (φPn, φM2n, φM3n) 

The effect of the strength reduction factor, φ, is included in the generation of 
the interaction surface. The value of φ used in the interaction diagram varies 
from compression-controlled φ to tension-controlled φ based on the maximum 
tensile strain in the reinforcing at the extreme edge, εt (ACI 21.2.1, 21.2.2, Ta-
ble 21.2.1, Table 21.2.2).  

Sections are considered compression-controlled when the tensile strain in the 
extreme tension steel is equal to or less than the compression-controlled strain 
limit at the time the concrete in compression reaches its assumed strain limit of 
εc.max, which is 0.003. The compression-controlled strain limit is the tensile 
strain in the reinforcement at balanced strain condition, which is taken as the 
yield strain of the steel reinforcing, fy /E (ACI 21.2.2.1, Table 21.2.2, Fig. 
R21.2.2b).  

Sections are tension-controlled when the tensile strain in the extreme tension 
steel is equal to or greater than 0.005, just as the concrete in compression 
reaches its assumed strain limit of 0.003 (ACI Table 21.2.2, Fig. R21.2.2b).  

Sections with εt between the two limits are considered to be in a transition 
region between compression-controlled and tension-controlled sections (ACI 
21.2.2, Table 21.2.2, Fig. R21.2.2b).  

When the section is tension-controlled, a φ factor for tension-control case is 
used. When the section is compression-controlled, a φ factor for compression-
control case is used. When the section falls into the transition region, φ  is 
linearly interpolated between the two values (ACI 21.2.2, Table 21.2.2, Fig. 
R21.2.2b), as shown in the following:  
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 (ACI 21.2.2) 

where, 
φt = φ for tension controlled sections,  
  which is 0.90 by default (ACI 21.2.1, Table 21.2.2) 
     
φc = φ for compression controlled sections   

 = 0.65 (by default) for wall sections 
   with tied reinforcement. (ACI 21.2.1, Table 21.2.2) 

In cases involving axial tension, the strength reduction factor, φ, is by default 
equal to φt. The strength reduction factors φc and φt can be revised in the 
preferences and the overwrites (Appendix A). 

The theoretical maximum nominal compressive force that the wall pier can 
carry, assuming the φc factor is equal to 1, is designated Poc and is given by. 

 Poc = [0.85f'c (Ag − As) + fyAs]  (ACI 21.4.4.2) 

The theoretical maximum nominal tension force that the wall pier can carry, 
assuming the φt factor is equal to 1, is designated Pot and is given by. 

 Pot = fyAs 

If the wall pier geometry and reinforcing is symmetrical in plan, the moments 
associated with both Poc and Pot are zero. Otherwise, a moment associated will 
be with both Poc and Pot. 

The code limits the maximum compressive design strength, φcPn, to the value 
given by Pmax  

 φPmax = 0.80φcPoc = 0.80φ[0.85f'c (Ag − As) + fyAs] (ACI 22.4.2.1) 

Note that the equation defining Pmax reduces Poc not only by a strength 
reduction factor, φc, but also by an additional factor of 0.80. In the preferences, 
this factor is called the Pmax Factor, and different values for it can be specified, as 
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required. In all code designs, it is prudent to consider this factor to be 0.80 as 
required by the code. 

Note: The number of points to be used in creating interaction diagrams can be speci-
fied in the shear wall preferences. 

As previously mentioned, by default, 11 points are used to define a single 
interaction curve. When creating a single interaction curve, the program 
includes the points at Pb, Poc and Pot on the interaction curve. Half of the 
remaining number of specified points on the interaction curve occur between 
Pb and Poc at approximately equal spacing along the φPn axis. The other half of 
the remaining number of specified points on the interaction curve occur 
between Pb and Pot at approximately equal spacing along the φPn axis. Here Pb 
is the nominal axial capacity at the balanced condition. 

Figure 2-5 shows a plan view of an example two-dimensional wall pier. Notice 
that the concrete is symmetrical but the reinforcing is not symmetrical in this 
example. Figure 2-6 shows several interaction surfaces for the wall pier 
illustrated in Figure 2-5.  

f’c = 4 ksi
fy = 60 ksi

1'
12'-6"

3"

# 5@12” o.c.,
each face, except
as noted3"12 spaces at 1'-0" = 12'-0" 

2-
#9

2-
#9

2-
#6

 

Figure 2-5: Example Two-Dimensional Wall Pier With Unsymmetrical 
Reinforcing 

Note the following about Figure 2-6: 

 Because the pier is two-dimensional, the interaction surface consists of two 
interaction curves. One curve is at 0° and the other is at 180°. Only M3 
moments are considered because this is a two-dimensional example. 

 In this program, compression is negative and tension is positive. 
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 The 0° and 180° interaction curves are not symmetric because the wall pier 
reinforcing is not symmetric. 

 The smaller interaction surface (drawn with a heavier line) has both the 
strength reduction factors and the Pmax Factor, applied as specified by the 
code. 

 The dashed line shows the effect of setting the Pmax Factor to 1.0. 

 The larger interaction surface has both the strength reduction factor and the 
Pmax,Factor set to 1.0. 

 The interaction surfaces shown are created using the default value of 11 
points for each interaction curve. 

 

Figure 2-6 : Interaction Curves for Example Wall Pier Shown in Figure 2-5 

Figure 2-7 shows the 0° interaction curves for the wall pier illustrated in Figure 
2-5. Additional interaction curves are also added to Figure 2-7.  
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The smaller, heavier curve in Figure 2-7 has the strength reduction factor and 
the Pmax,Factor as specified in ACI 318-14. The other three curves, which are 
plotted for φ = 0.65, 0.9 and 1.0, all have Pmax,Factor of 1.0. The purpose of 
showing these interaction curves is to explain how the program creates the 
interaction curve. Recall that the strength reduction factors 0.65 and 0.9 are 
actually φc and φt, and that their values can be revised in the preferences as 
required. 

 

 

Figure 2-7: Interaction Curves for Example Wall Pier Shown in Figure 2-5 

2.1.2.3 Details of the Strain Compatibility Analysis 
As previously mentioned, the program uses the requirements of force 
equilibrium and strain compatibility to determine the nominal axial strength 
and moment strength (Pn, M2n, M3n) of the wall pier. The coordinates of these 
points are determined by rotating a plane of linear strain on the section of the 
wall pier. 

Figure 2-8 illustrates varying planes of linear strain such as those that the 
program considers on a wall pier section for a neutral axis orientation angle of 
0 degrees. 

2-14 Wall Pier Flexural Design 



 Chapter 2 Pier Design 
 

In these planes, the maximum concrete strain is always taken as −0.003 and the 
maximum steel strain is varied from −0.003 to plus infinity. (Recall that in this 
program compression is negative and tension is positive.) When the steel strain 
is −0.003, the maximum compressive force in the wall pier, Poc, is obtained 
from the strain compatibility analysis. When the steel strain is plus infinity, the 
maximum tensile force in the wall pier, Pot, is obtained. When the maximum 
steel strain is equal to the yield strain for the reinforcing (e.g., 0.00207 for fy = 
60 ksi), Pb is obtained. 

Varying
neutral axis
locations

Varying Linear Strain Diagram

Plan View of Wall Pier

-0.003

0.000

+ ε

- ε

Varying
neutral axis
locations

Varying Linear Strain Diagram

Plan View of Wall Pier

-0.003

0.000

+ ε

- ε

 
Figure 2-8: Varying Planes of Linear Strain 

Figure 2-9 illustrates the concrete wall pier strain, stress, and force that is 
obtained from a strain compatibility analysis of a typical plane of linear strain 
shown in Figure 2-8. In Figure 2-9 the compressive stress in the concrete, Cc, is 
calculated (ACI 21.2.2.4.1). 

 Cc = 0.85f'cβ1ctp (ACI 21.2.2.4.1) 

In Figure 2-8, the value for maximum strain in the reinforcing steel is assumed. 
Then the strain in all other reinforcing steel is determined based on the 
assumed plane of linear strain. Next the stress in the reinforcing steel is 
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calculated as follows, where εs is the strain, Es is the modulus of elasticity, σs 
is the stress, and fy is the yield stress of the reinforcing steel. 

 σs = εsEs ≤ fy  (ACI 20.2.2) 
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Figure 2-9: Wall Pier Stress-Strain Relationship 

The force in the reinforcing steel (Ts for tension or Cs for compression) is 
calculated by: 

 Ts or Cs = σsAs 

For the given distribution of strain, the value of φPn is calculated by. 

2-16 Wall Pier Flexural Design 



 Chapter 2 Pier Design 
 

 φPn = φ(ΣTs − Cc − ΣCs) ≤ φPmax 

In the preceding equation, the tensile force Ts and the compressive forces Cc 
and Cs are all positive. If φPn is positive, it is tension, and if it is negative, it is 
compression. 

The value of φM2n is calculated by summing the moments due to all of the 
forces about the pier local 2 axis. Similarly, the value of φM3n is calculated by 
summing the moments due to all of the forces about the pier local 3 axis. The 
forces whose moments are summed to determine φM2n and φM3n are φCc, all of 
the φTs forces and all of the φCs forces. 

The φPn, φM2n and φM3n values calculated as described in the preceding 
paragraph make up one point on the wall pier interaction diagram. Additional 
points on the diagram are obtained by making different assumptions for the 
maximum steel strain; that is, considering a different plane of linear strain, and 
repeating the process. 

When one interaction curve is complete, the next orientation of the neutral axis 
is assumed and the points for the associated new interaction curve are 
calculated. This process continues until the points for all of the specified curves 
have been calculated. 

2.1.3 Wall Pier Demand/Capacity Ratio 
Refer to Figure 2-10, which shows a typical two-dimensional wall pier 
interaction diagram. The forces obtained from a given design load combination 
are Pu and M3u. The point L, defined by (Pu, M3u), is placed on the interaction 
diagram, as shown in the figure. If the point lies within the interaction curve, 
the wall pier capacity is adequate. If the point lies outside of the interaction 
curve, the wall pier is overstressed. 

As a measure of the stress condition in the wall pier, the program calculates a 
stress ratio. The ratio is achieved by plotting the point L and determining the 
location of point C. The point C is defined as the point where the line OL 
(extended outward if needed) intersects the interaction curve. The 
demand/capacity ratio, D/C, is given by D/C = OL / OC where OL is the 
"distance" from point O (the origin) to point L and OC is the "distance" from 
point O to point C. Note the following about the demand/capacity ratio: 
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 If OL = OC (or D/C = 1), the point (Pu, M3u) lies on the interaction curve 
and the wall pier is stressed to capacity. 

 If OL < OC (or D/C < 1), the point (Pu, M3u) lies within the interaction 
curve and the wall pier capacity is adequate. 

 If OL > OC (or D/C > 1), the point (Pu, M3u) lies outside of the interaction 
curve and the wall pier is overstressed. 

The wall pier demand/capacity ratio is a factor that gives an indication of the 
stress condition of the wall with respect to the capacity of the wall. 

The demand/capacity ratio for a three-dimensional wall pier is determined in a 
similar manner to that described here for two-dimensional piers. 

 
Figure 2-10: Two-Dimensional Wall Pier Demand/Capacity Ratio 

2.1.4 Designing a General Reinforcing Pier Section 
When a General Reinforcing pier section is specified to be designed, the 
program creates a series of interaction surfaces for the pier based on the 
following items: 

 The size of the pier as specified in Section Designer. 
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 The location of the reinforcing specified in Section Designer. 

 The size of each reinforcing bar specified in Section Designer relative to the 
size of the other bars. 

The interaction surfaces are developed for eight different ratios of reinforcing-
steel-area-to-pier-area. The pier area is held constant and the rebar area is 
modified to obtain these different ratios; however, the relative size (area) of 
each rebar compared to the other bars is always kept constant. 

The smallest of the eight reinforcing ratios used is that specified in the shear 
wall design preferences as Section Design IP-Min. Similarly, the largest of the 
eight reinforcing ratios used is that specified in the shear wall design 
preferences as Section Design IP-Max. 

The eight reinforcing ratios used are the maximum and the minimum ratios 
plus six more ratios. The spacing between the reinforcing ratios is calculated as 
an increasing arithmetic series in which the space between the first two ratios is 
equal to one-third of the space between the last two ratios. Table 1 illustrates 
the spacing, both in general terms and for a specific example, when the 
minimum reinforcing ratio, IPmin, is 0.0025 and the maximum, IPmax, is 0.02. 

Table 2-1 The Eight Reinforcing Ratios Used by the Program 
Curve Ratio Example 

1 IPmin  0.0025 

2 
IPmax IPminIPmin +

14
−  0.0038 

3 
7 IPmax IPminIPmin +
3 14

− 
 
 

 0.0054 

4 
IPmax IPminIPmin + 4

14
− 

 
 

 0.0075 

5 
IPmax IPminIPmin + 6

14
− 

 
 

 0.0100 

6 
25 IPmax IPminIPmin +
3 14

− 
 
 

 0.0129 

7 
IPmax IPminIPmin + 11

14
− 

 
 

 0.0163 

8 IPmax  0.0200 
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After the eight reinforcing ratios have been determined, the program develops 
interaction surfaces for all eight of the ratios using the process described earlier 
in the section entitled "Checking a General or Uniform Reinforcing Pier 
Section." 

Next, for a given design load combination, the program generates a 
demand/capacity ratio associated with each of the eight interaction surfaces. 
The program then uses linear interpolation between the eight interaction 
surfaces to determine the reinforcing ratio that gives an demand/capacity ratio 
of 1 (actually the program uses 0.99 instead of 1). This process is repeated for 
all design load combinations and the largest required reinforcing ratio is 
reported. 

Design of a Uniform Reinforcing pier section is similar to that described herein 
for the General Reinforcing section. 

2.2 Wall Pier Shear Design 
The wall pier shear reinforcing is designed leg by leg (panel by panel) for each 
of the design load combinations. The following steps are involved in designing 
the shear reinforcing for a particular wall pier section for a particular design 
loading combination. 

 Determine the factored forces Pu, Mu and Vu that are acting on a leg of the 
wall pier section. Note that Pu and Mu are required for the calculation of Vc. 

 Determine the shear force, Vc, that can be carried by the concrete of the leg 
(panel). 

 Determine the required shear reinforcing to carry the balance of the shear 
force. 

Step 1 needs no further explanation. The following two sections describe in 
detail the algorithms associated with the Steps 2 and 3. 
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2.2.1 Determine the Concrete Shear Capacity of the Leg 
Given the design force set Pu, Mu and Vu acting on a wall pier section, the shear 
force carried by the concrete, Vc, is calculated using the minimum from the 
following two equations (ACI 11.5.4.6).  

 3 3
4

u
c c p

p

N dV . f t d
L

′= λ +  (ACI 11.5.4.6, Table 11.5.4.6) 
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 (ACI 11.5.4.6, Table 11.5.4.6) 

The last of the two above equations does not apply if 
pu

u

LMAbs
V 2

 
− 

   is negative 

or zero, or if Vu is zero.  

In the preceding equations, Nu is the axial force, and Nu is positive for 
compression and negative for tension. The effective shear depth, d, is taken as 
follows: 

 d = 0.8 Lp (ACI 11.5.2) 

A limit of 100 psi on cf ′  is imposed, 

 cf ′  ≤ 100 psi (ACI 22.5.3.1) 

If the tension is large enough that any of the above two equations for Vc results 
in a negative number, Vc is set to zero.  

Note that the term λ that is used as a multiplier on all cf ′  terms in this 
chapter is a shear strength reduction factor that applies to light-weight concrete. 
The factor λ shall normally be 0.75 for lightweight concrete and 1.0 for normal 
weight concrete (ACI Table 19.2.4.2). However, the program allows the user to 
define the value while defining concrete material property. The program uses 
the user input value for λ. 
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Given Vu and Vc, the required shear reinforcement of area/unit length is 
calculated as follows: 

 The shear force is limited to a maximum of  

 ( )max 10 ,c cpV f t d′=   where (ACI 11.5.4.3) 

 d = 0.8Lp (ACI 11.5.2) 

 The required horizontal shear reinforcement per unit spacing, Av /s, is calcu-
lated as follows:  

If ( )2 ,u cV V≤ φ  

 ,min ,v
t cp

A t
s

ρ=  (ACI 11.6.1, Table 11.6.1) 

else if max ,c uV V Vφ < ≤ φ  

 
( )u cv

ys

V VA
s f d

− φ
=

φ
, (ACI 11.5.4.8, 11.5.4.4) 

 ,min
v

t p
A t
s

ρ≥  (ACI 11.6.2) 

else if max ,uV V> φ  

 a failure condition is declared. (ACI 11.5.4.3) 

In the preceding equations, the strength reduction factor φ is taken as 0.75 for 
non-seismic cases φvs (ACI 21.2.1), and as 0.6 for seismic cases φvs (ACI 
21.2.1, 21.2.4). However, those values may be overwritten by the user if so 
desired.  

If Vu exceeds the maximum permitted value of φVmax, the shear wall section 
should be increased in size (ACI 11.5.4.3).  

The minimum horizontal volumetric shear rebar ratio, ,mintρ , and the minimum 
vertical volumetric shear rebar ratio, ,minlρ ,  are calculated as follows: 
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If Vu ≤ ( )2 ,cVφ  

 ,min 0.0025tρ =  (ACI 11.6.1, Table 11.6.1) 

 ,min 0.0025lρ =  (ACI 11.6.1, Table 11.6.1) 

else if Vu > ( )2 ,cVφ  

 ,min 0.0025tρ =  (ACI 11.6.2(b)) 

 ( )( ),min 0.0025 0.5 2.5 0.0025 0.0025l w p th Lρ = + − ρ − ≥  (ACI 11.6.2(a)) 

where, 

  v
t

p

A
st

ρ =  (ACI R11.6.1) 

 st
l

p p

A
L t

ρ =  (ACI R11.6.1) 

 hw = Story height,  

 tp = Thickness of the shear wall panel, and  

 Lp = Length of the shear wall panel. 

For shear design of special seismic wall pier legs for seismic load, the 
procedure given in this section is modified with the following exceptions. 

 The concrete shear capacity is taken as follows (ACI 18.10.4.1): 

 c c c cvV f A′= α λ  (ACI 18.10.4.1) 

where, 

 
3.0 for 1.5,

2.0 for 2.0,

interpolated for 1.5 2.0.

w p

c w p

w p

h L

h L

h L

 ≤


α = >
 < <

 (ACI 18.10.4.1) 
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 Acv = Lptp (ACI 18.10.4) 

 The maximum shear that can be carried by the wall segment irrespective of 
the amount of reinforcing bar provided is taken as follows (ACI 18.10.4.4): 

Vmax = 8 cf ′ Lptp (ACI 18.10.4.1) 

 The expression for required shear rebar is modified as follows: 

 
( )u c c p p vsv

ys p

V f L tA
s f L

′− α λ φ
=  (ACI 21.9.4.1) 

 If Vu exceeds ( )c p pf L t′λ , the ,mintρ and ,minlρ  is modified as follows: 

 ,min 0.0025tρ =  (ACI 18.10.2.1) 

 ,min 0.0025lρ =  (ACI 18.10.2.1) 

The maximum of all of the calculated Av /s values, obtained from each design 
load combination, is reported along with the controlling shear force and 
associated design load combination name.  

The pier horizontal shear reinforcement requirements reported by the program 
are based purely on shear strength considerations. Any minimum shear rebar 
requirements to satisfy spacing consideration must be investigated 
independently of the program by the user.  

2.3 Wall Pier Boundary Elements 
This section describes how the program considers the boundary element 
requirements for each leg of concrete wall piers using the code when the 
Special Structural Wall option is chosen. The program uses an approach based 
on the requirements of Section 18.10.6 of the code. The program does not 
compute boundary zone requirement when maximum extreme fiber 
compressive stress is less than 0.15 cf ′ (ACI 18.10.6.3). When the extreme fiber 
compressive stress is equal to or greater than 0.15 cf ′ (ACI 18.10.6.3), the 
program also checks ACI Section 18.10.6.2 and reports the boundary zone 
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requirement when the depth of the compression zone exceeds a limit (ACI 
18.10.6.2). The depth of compression zone when stress is below 0.2 cf ′  but 
higher than 0.15 cf ′  is reported so user can determine the zone where boundary 
zone need to be continued in accordance with ACI section 18.10.6.3. Boundary 
zone  is permitted to be discontinued when stress in boundary zone is less than 
0.15 cf ′ . 

Note that the boundary element requirements are considered separately for 
each design load combination that includes seismic load.  

2.3.1 Details of Check for Boundary Element Requirements 
The following information is made available for the boundary element check: 

 The design forces Pu, Vu, and Mu for the pier section. 

 The story height, hw, length of the wall pier panel, Lp, the gross area of the 
pier, Ag, and the net area of the pier, Acv. The net area of the pier is the area 
bounded by the web thickness, tp, and the length of the pier. (Refer to Figure 
2-3 earlier in this chapter for an illustration of the dimensions Lp and tp.) 

 The program also computes the design displacement δu by multiplying the 
displacement from load combination with the Cd factor provided in the shear 
wall design preferences (Appendix B). 

 The area of reinforcement in the pier, As. This area of steel is calculated by 
the program or it is provided by the user. 

 The material properties of the pier, cf ′ and fy. 

 The symmetry of the wall pier (i.e., the left side of the pier is the same as the 
right side of the pier). Only the geometry of the pier is considered, not the 
reinforcing, when determining if the pier is symmetrical. Figure 2-11 shows 
some examples of symmetrical and unsymmetrical wall piers. Note that a 
pier defined using Section Designer is assumed to be unsymmetrical, unless 
it is made up of a single rectangular shape. 
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Figure 2-11 Example Plan Views of Symmetrical and Unsymmetrical Wall Piers 

Using this information, the program calculates the maximum compressive 
stress at extreme fiber of concrete pier for the specified load combination. 

After the compressive stress at the extreme fiber of the concrete pier is known, 
the program calculates the following quantities that are used to determine the 

boundary zone requirements. These quantities are:  bc, 0 2 c. f ,′ u w/ hδ ,  c. 

When the extreme fiber compressive stress, bc, exceeds 0.2 ,cf ′  boundary 
elements are required (ACI 18.10.6.3), or when the neutral axial depth 
calculated from the factored axial force and nominal moment strength are 
consistent with design displacement, δu, and exceed the following limit: 

( )600 1.5 
w

u w

l
c

/ hδ
≥   (ACI 18.10.6.2) 

where, 

 ,elastic analysis  d
u u

C
I

 δ = δ  
 

 (ASCE 7-10, 12.8-15) 

 Cd = The deflection amplification factor as taken from ASCE 7-10 Table 
12.2-1. It is input in the preferences. 

 I = The Importance factor determined in accordance with Section 
ASCE 11.5.1. It is input in the preferences. 

 0.005u whδ ≤  (ACI 18.10.6.2(a)) 
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boundary elements are required (ACI 18.10.6). 

The program also reports the largest neutral axis depth for each leg and the  
boundary zone length computed using ACI 18.10.6.4(a) when the boundary 
zone is Not Needed.  This information is provided so the user can satisfy the 
requirement of  ACI Section 18.10..6.4(a) and 18.10..6.5 when the longitudinal 
reinforcement ratio at the wall boundary is greater than 400/ yf . 

If boundary elements are required, the program calculates the minimum 
required length of the boundary zone at each end of the wall, LBZ, which is 
calculated as follows: 

 LBZ = { }max 2, 0.1 .wc c L−  (ACI 18.10.6.4(a)) 

Figure 2-12 illustrates the boundary zone length LBZ.  

 

Figure 2-12: Illustration of Boundary Zone Length, LBZ 

2.3.2 Transverse Reinforcement for Boundary Elements 
Where special boundary elements are required by ACI Sections 18.10.6.2 or 
18.10.6.3, the wall boundary elements need the total cross-sectional area of 
rectangular hoop reinforcement as follows (ACI 18.10.6.4(c), 18.10.6.4(b)): 

 0.09sh p c ytA s t f f′=  (ACI 21-5) 

Where special boundary elements are not required by ACI Sections 18.10.6.2 
or 21.9.6.3, and the longitudinal reinforcement ratio at the wall boundary is 
greater than 400/ ,yf  the user should independently satisfy the requirements of 

ACI Sections 18.10.6.1(c), 18.10.4.2, and 18.10.6.5. 
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However, the program does not calculate and report these values. The user 
should independently satisfy the requirements of the sections. 
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Chapter 3 
Spandrel Design 

This chapter describes how the program designs concrete shear wall spandrels 
for flexure and shear when ACI 318-14 is the selected design code.  The 
program allows consideration of rectangular sections and T-beam sections for 
shear wall spandrels. Note that the program designs spandrels at stations 
located at the ends of the spandrel. No design is performed at the center (mid-
length) of the spandrel. The program does not allow shear reinforcing to be 
specified and then checked. The program only designs the spandrel for shear 
and reports how much shear reinforcing is required. 

3.1 Spandrel Flexural Design 
In this program, wall spandrels are designed for major direction flexure and 
shear only. Effects caused by any axial forces, minor direction bending, torsion 
or minor direction shear that may exist in the spandrels must be investigated by 
the user independent of the program. Spandrel flexural reinforcing is designed 
for each of the design load combinations. The required area of reinforcing for 
flexure is calculated and reported only at the ends of the spandrel beam. 

The following steps are involved in designing the flexural reinforcing for a par-
ticular wall spandrel section for a particular design loading combination at a 
particular station. 
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 Determine the maximum factored moment Mu. 

 Determine the required flexural reinforcing. 

These steps are described in the following sections. 

3.1.1 Determine the Maximum Factored Moments 
In the design of flexural reinforcing for spandrels, the factored moments for 
each design load combination at a particular beam station are first obtained.  

The beam section is then designed for the maximum positive and the maximum 
negative factored moments obtained from all of the design load combinations. 

3.1.2 Determine the Required Flexural Reinforcing 
In this program, negative beam moments produce top steel. In such cases, the 
beam is always designed as a rectangular section. 

In this program, positive beam moments produce bottom steel. In such cases, 
the beam may be designed as a rectangular section, or as a T-beam section. To 
design a spandrel as a T-beam, specify the appropriate slab width and depth 
dimensions in the spandrel design overwrites (Appendix B). 

The flexural design procedure is based on a simplified rectangular stress block, 
as shown in Figure 3-1. The maximum depth of the compression zone, cmax, is 
calculated based on the limitation that the tensile steel tension shall not be less 
than εs,min, which is equal to 0.005 for tension controlled behavior (ACI 9.3.3.1, 
21.2.2, Fig. R21.2.2b):  

                ,max
max

,max ,min

c

c s
c d

ε
=
ε + ε

   (ACI 21.2.2) 

where, 

 εc,max = 0.003   (ACI 21.2.2, Fig. R21.2.2b) 

 εs,min = 0.005  (ACI 21.2.2, Fig. R21.2.2b) 
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Figure 3-1  Rectangular Spandrel Beam Design, Positive Moment 

The maximum allowable depth of the rectangular compression block, amax, is 
given by 

 max 1 maxa c= β   (ACI 22.2.2.4.1) 

where β1 is calculated as follows: 

 1
4000

0 85 0 05
1000

cf
. .

′ − 
β = −  

 
, 0.65 ≤ β1 ≤ 0.85             (ACI 22.2.2.4.3) 

It is assumed that the compression depth carried by the concrete is less than or 
equal to amax. When the applied moment exceeds the moment capacity at amax, 
the program calculates an area of compression reinforcement assuming that the 
additional moment is carried by compression reinforcing and additional tension 
reinforcing. 

The procedure used by the program for both rectangular and T-beam sections 
is given in the subsections that follow.  

3.1.2.1 Rectangular Beam Flexural Reinforcing 
Refer to Figure 3-1. For a rectangular beam with tensile side reinforcement 
only, the factored moment, Mu, is resisted by a couple between the concrete in 
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compression and the tension in reinforcing steel. This expression is given as 
follows. 

 spandrel 2u c
aM C d = − 

 
 

Where Cc = 0.85φb cf ′ ats and dspandrel is equal to hs − dr-bot for positive bending 
and hs − dr-top for negative bending. 

In designing for a factored negative or positive moment, Mu (i.e., designing top 
or bottom steel), the depth of the compression block is given by a. 

 2
spandrel spandrel

2
0.85

u

c b s

Ma d d
f t

= − −
′ φ

 (ACI 22.2) 

The program uses the preceding equation to determine the depth of the com-
pression block, a. The depth of the compression block, a, is compared with 
amax. 

3.1.2.1.1 Tension Reinforcing Only Required 
 If a ≤ amax (ACI 9.3.3.1, 21.2.2, 22.2.2.4.1), the area of tensile steel 

reinforcement is then given by 

 
spandrel 2

u
s

b y

MA
af d

=
 φ − 
 

 

The steel is placed at the bottom for positive moment and at the top for nega-
tive moment. 

Note: The program reports the ratio of top and bottom steel required in the web area. 
When compression steel is required, those ratios may be large because there is no limit 
on them. However, the program reports an overstress when the ratio exceeds 4%. 

3.1.2.1.2 Tension and Compression Reinforcing Required 
 If a > amax, compression reinforcement is required (ACI 9.3.3.1, 21.2.2, 

22.2.2.4.1) and is calculated as follows:  
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The depth of the concrete compression block, a, is set equal to a = amax. 
The compressive force developed in the concrete alone is given by 

 c c sC f a t′= max0.85 . (ACI 22.2.2.4.1) 

The moment resisted by the couple between the concrete in compression 
and the tension steel, Muc, is given by 

 max
spandrel 2uc b c

aM C d = φ − 
 

. 

Therefore, the additional moment to be resisted by the couple between the 
compression steel and the additional tension steel, Mus, is given by 

 us u ucM M M= −  

The force carried by the compression steel, Cs, is given by 

 
spandrel

us
s

r

MC
d d

=
−

. 

Referring to Figure 3-1, the strain in the compression steel, ε's, is given by 

 ( ),maxc r
s

c d
c

ε −′ε = . 

The stress in the compression steel, f 's, is given by 

 ( ),maxc s r
s s s

E c d
f E

c
ε −′ ′= ε = . (ACI 9.2.1.2, 9.5.2.1, 20.2.2, 22.2.1.2) 

The term dr in the preceding equations is equal to dr-top for positive bending 
and equal to dr-bot for negative bending. The term c is equal to max 1.a β  

The total required area of compression steel, A's, is calculated using the follow-
ing equation. 

 
( 0.85 )

s
s

b s c

CA
f f

′ =
′ ′φ −

. 
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The required area of tension steel for balancing the compression in the concrete 
web, Asw, is: 

 
max

spandrel 2

uc
sw

b y

MA
af d

=
 φ − 
 

. 

The required area of tension steel for balancing the compression steel, Asc, is: 

 
( )spandrel

us
sc

b y r

MA
f d d

=
φ −

. 

In the preceding equations, dspandrel is equal to hs − dr-bot for positive bending 
and hs − dr-top for negative bending. dr is equal to dr-top for positive bending and 
dr-bot for negative bending. 

The total tension reinforcement As is given by. 

 s sw scA A A= +   

The total tension reinforcement As is to be placed at the bottom of the spandrel 
beam and total compression reinforcement As' at the top for positive bending 
and vice versa for negative bending. 

3.1.2.2 T-Beam Flexural Reinforcing 
T-beam action is considered effective for positive moment only. When design-
ing T-beams for negative moment (i.e., designing top steel), the calculation of 
required steel is as described in the previous section for rectangular sections. 
No T-beam data is used in this design. The width of the beam is taken equal to 
the width of the web. 

For positive moment, the depth of the compression block, a, and the method 
for calculating the required reinforcing steel relates the compression block 
depth, a, as previously described in Section 3.1.2, to the depth of the T-beam 
flange, ds. See Figure 3-2. 

 If a ≤ ds, the subsequent calculations for the reinforcing steel are exactly 
the same as previously defined for rectangular section design. However, in 
that case, the width of the compression block is taken to be equal to the 
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width of the compression flange, bs. Compression reinforcement is provid-
ed when the dimension a exceeds amax. 

 If a > ds, the subsequent calculations for the required area of reinforcing 
steel are performed in two parts. First, the tension steel required to balance 
the compressive force in the flange is determined, and second, the tension 
steel required to balance the compressive force in the web is determined. If 
necessary, compression steel is added to help resist the design moment. 

The remainder of this section describes in detail the design process used by the 
program for T-beam spandrels when a > ds. 

Refer to Figure 3-2. The protruding portion of the flange is shown cross-
hatched. The compression force in the protruding portion of the flange, Cf, is 
given by.  

 ( )f c s s sC f b t d′= −0.85   (ACI 22.2.2.4.1) 

Note: T-beam action is considered for positive moment only. 

The required area of tension steel for balancing the compression force in the 
concrete flange, Asf, is: 

 f
sf

y

C
A

f
=  

The portion of the total moment, Mu, that is resisted by the flange, Muf, is given 
by. 

 spandrel 2
s

uf b f
dM C d = φ − 

 
 

Therefore, the balance of the moment to be carried by the web, Muw, is given 
by 

 uw u ufM M M= −  
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Figure 3-2: Design of a Wall Spandrel with a T-Beam Section, Positive Moment 

The web is a rectangular section of width ts and depth hs for which the design 
depth of the compression block, a1, is recalculated as: 

 2
1 spandrel spandrel

2
0.85

uw

c b s

Ma d d
f t

= − −
′ φ

. 

3.1.2.2.1 Tension Reinforcing Only Required 
If a1 ≤ amax, no compression reinforcing is required and the program calculates 
the area of tension steel for balancing the compression force in the concrete 
web, Asw, using the following equation. 

 
1

spandrel 2

uw
sw

b y

MA
af d

=
 φ − 
 

. 

The total tension reinforcement As is given by: 

 s sf swA A A= + . 

The total tension reinforcement, As, is to be placed at the bottom of the beam 
for positive bending. 
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3.1.2.2.2 Tension and Compression Reinforcing Required 
 If a1 > amax, compression reinforcing is required. In that case, the required 

reinforcing is computed as follows. 

The depth of the concrete compression block, a, is set equal to a = amax. 
The compressive force developed in the web concrete alone is given by 

 w c sC f at′= 0.85 . 

The moment resisted by the couple between the concrete web in compres-
sion and the tension steel, Muc, is given by 

 spandrel 2uc b w
aM C d = φ − 

 
. 

Therefore, the additional moment to be resisted by the couple between the 
compression steel and the tension steel, Mus, is given by: 

 us uw ucM M M= − . 

Referring to Figure 3-2, the force carried by the compression steel, Cs, is 
given by: 

 
spandrel r-top

us
s

MC
d d

=
−

 

The strain in the compression steel, εs', is given by 

 
( ),max r-topc

s
c d
c

ε −′ε = . 

The stress in the compression steel, fs', is given by 

 
( ),max r-topc s

s s s
E c d

f E
c
−′ ′= =

ε
ε . 

The term c is equal to max 1a β . 

The required area of compression steel, As', is calculated using  
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 s
s

b s

CA
f

′ =
′φ

 

The required area of tension steel for balancing the compression in the concrete 
web, Asw, is: 

 
spandrel

.

2

uc
sw

b y

MA
af d

=
 φ − 
 

 

The required area of tension steel for balancing the compression steel, Asc, is: 

 
( )spandrel r-top

us
sc

b y

MA
f d d

=
φ −

. 

The total tension reinforcement As is given by 

 s sf sw scA A A A= + + . 

The total tension reinforcement, As is to be placed at the bottom of the beam, 
and total compression reinforcement, As' at the top of the beam. 

3.2 Spandrel Shear Design 
The program allows consideration of rectangular sections and T-beam sections 
for wall spandrels. The shear design for both of these types of spandrel sections 
is identical. 

The wall spandrel shear reinforcing is designed for each of the design load 
combinations. The required area of reinforcing for vertical shear is calculated 
only at the ends of the spandrel beam. 

In this program, wall spandrels are designed for major direction flexure and 
shear forces only. Effects caused by any axial forces, minor direction bending, 
torsion or minor direction shear that may exist in the spandrels must be investi-
gated by the user independent of the program. 
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The following steps are involved in designing the shear reinforcing for a par-
ticular wall spandrel section for a particular design loading combination at a 
particular station. 

1. Determine the factored shear force Vu. 

2. Determine the shear force, Vc, that can be carried by the concrete. 

3. Determine the required shear reinforcing to carry the balance of the shear 
force. 

Note: In the overwrites, Vc can be specified to be ignored (set to zero) for spandrel 
shear calculations. 

Step 1 needs no further explanation. The following two sections describe in de-
tail the algorithms associated with Steps 2 and 3. 

3.2.1 Determine the Concrete Shear Capacity 
The shear force carried by the concrete, Vc, is given by  

 spandrel2c c sV f t d′= λ  (ACI 22.5.5.1) 

The shear force carried by the concrete, Vc, is calculated using the following 
equation when the spandrel is subjected to axial compression.  

 spandrel2 1
2000

u
c c s

g

NV f t d
A

 
′= λ +  

 
  (ACI 22.5.6.1, Table 22.5.6.1(b)) 

The shear force carried by the concrete, Vc, is calculated using the following 
equation when the spandrel is subjected to axial tension. Nu is negative for ten-
sion. 

 spandrel2 1 0
500

u
c c s

g

NV f t d
A

 
′= + ≥  

 
λ  (ACI 22.5.7.1) 

Note that an overwrite is available that can be used to ignore the concrete con-
tribution to the shear strength of the spandrel. If this overwrite is activated, the 
program sets Vc to zero for the spandrel. 
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In all of the preceding cases, a limit on cf ′  is imposed as 100 psi. 

 cf ′  ≤ 100 psi (ACI 22.5.3.1) 

The factor λ shall normally be 0.75 for lightweight concrete and 1.0 for normal 
weight concrete (ACI Table 19.2.4.2). However, the program allows the user to 
define the value while defining concrete material property. The program uses 
the user input value for λ. 

3.2.2 Determine the Required Shear Reinforcing 
One of the terms used in calculating the spandrel shear reinforcing is dspandrel, 
which is the distance from the extreme compression fiber to the centroid of the 
tension steel. For shear design, the program takes dspandrel to be equal to the 
smaller of hs − dr-top and hs − dr-bot. 

3.2.2.1 Seismic and Nonseismic Spandrels 
In this entire subsection the term φ is equal to φvns for nonseismic spandrels and 
to φvs for seismic spandrels. 

Given Vu and Vc, the required force to be carried by the shear reinforcing, Vs, is 
given by (ACI 22.5.1.1, 22.5.10.1). 

 u
s n c c

VV V V V= − = −
φ

  (ACI 22.5.1.1, 22.5.10.1) 

If Vs as calculated exceeds spandrel
′8 ,c sf t d  a failure condition is reported (ACI 

22.5.1.2). 

Given Vs, initially calculate the required vertical shear reinforcing in area per 
unit length (e.g., in2/in) for both seismic and nonseismic wall spandrels (as in-
dicated in the preferences). Note that additional requirements that are checked 
for both seismic and nonseismic wall spandrels are given by the following 
equation (ACI 20.5.10.5.3): 

 
spandrel spandrel

v s u c

ys ys

A V V V
s f d f d

φ −
= =   (ACI 20.5.10.5.3, 11.5.4.8) 
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The output units for the distributed shear reinforcing can be set in the Display 
Units preferences. 

The following additional checks also are performed for both seismic and non-
seismic spandrels. 

 When 
spandrel

sL
d

> 4 , the program verifies: 

 spandrel8u c c sV V f t dφ  ′≤ + 
 

,  (ACI 22.5.1.2) 

otherwise a failure condition is declared. 

 When 
spandrel

4 and 0.5s u
c

L V V
d

> >
φ

 (ACI 9.6.3), the minimum areas of verti-

cal and horizontal shear reinforcing in the spandrel are as follows: 

 ,min 500.75v s s
c

ys ys

A t tf
s f f

′= ≥  (ACI 9.6.3.3, Table 9.6.3.3) 

 -min 0.hA
s

=  (ACI 9.6.3.1) 

 When 
spandrel

4 and 0.5 ,s u
c

L V V
d

> ≤
φ

 the minimum areas of vertical and hori-

zontal shear reinforcing in the spandrel are as follows (ACI 9.6.3.1): 

 -min -min 0.v hA A
s s

= =  (ACI 9.6.3.1) 

 When 
spandrel

sL
d

≤ 4 , the program verifies: 

 spandrel10u c sV f t d′≤ φ  (ACI 9.9.2.1) 

otherwise a failure condition is declared. 
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For this condition, the minimum areas of horizontal and vertical shear rein-
forcing in the spandrel are: 

 -min 0.0025v sA t=  (ACI 9.9.3.1(a)) 

 -min 0.0025 .h sA t=  (ACI 9.9.3.1(b)) 

When calculating the Ls /dspandrel term, the program always uses the smallest 
value of dspandrel that is applicable to the spandrel. 

3.2.2.2 Seismic Spandrels Only 
For seismic spandrels only, in addition to the requirements of the previous sub-
section, an area of diagonal shear reinforcement in coupling beams is also cal-

culated when 
spandrel

sL
d

≤ 4   using the following equation (ACI 18.10.7.2, 

18.10.7.3).  

 
2 sin

u
vd

s ys

VA
f

=
φ α

, (ACI 18.10.7.4) 

where sφ = 0.75 (ACI 21.2-1, Table 21.2.1), and 

 
2 2

0.8sin
(0.8 )

s

s s

h

L h
α =

+
, 

where hs is the height of the spandrel and Ls is the length of the spandrel. 

In the output, the program reports the diagonal shear reinforcing as required or 
not required (i.e., optional). The diagonal shear reinforcing is reported as re-

quired when c spandrel4 fuV db′> λ  and spandrel 2sL d ≤ (ACI 18.10.7.2, 

18.10.7.3).  

For nonseismic spandrels, Avd is reported as zero. 
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Chapter 4  
Design Output 

The program has the capacity to create design output in four major ways – 
graphical display, file output, tabular display, and member specific detailed de-
sign information. The graphical display includes input and output design in-
formation for members visible in the active window; the display can be sent di-
rectly to a printer or saved to a file. The file output includes both summary and 
detail design data that can be saved in plain text formats.  The tabular display 
output includes both summary and detail design data that can be displayed or 
saved in many formats, including Excel, Access, RTF, HTML and plain text. 
The member specific detailed design information shows the details of the cal-
culation.  

The following sections describe some of the typical graphical display, file out-
put, tabular display output, and member specific detailed design information. 
Some of the design information is very specific to the chosen shear wall design 
code. This manual addresses "ACI 318-14" design code related output infor-
mation only.  

4.1 Graphical Display of Design Information 
The graphical display of design output includes input and output design infor-
mation for all shear wall members that are visible in the active window. The 
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graphical output can be produced in color or in gray-scaled screen display. The 
active screen display can be sent directly to the printer or saved to a file in sev-
eral formats.  

Use the Design menu > Shear Wall Design > Display Design Info command 
to display on-screen output plotted directly on the model. If desired, the screen 
graphics can then be printed using the File menu > Print Graphics command. 
The on-screen display data is organized into two main groups, as follows. 

Design Input 

 Material 

 Thickness 

 Pier length/spandrel depth 

 Section Designer pier sections 

Design Output 

 Simplified pier longitudinal reinforcing 

 Simplified pier edge members 

 Section Designer pier reinforcing ratios 

 Section Designer pier D/C ratios 

 Spandrel longitudinal reinforcing 

 Shear reinforcing 

 Pier demand/capacity ratios 

 Pier boundary zones 

Note that you cannot display more than one of the listed items on the model at 
the same time.  

The output plotted directly on piers is plotted along an invisible line that ex-
tends from the centroid of the pier section at the bottom of the pier to the cen-
troid of the pier section at the top of the pier. Similarly, the output plotted di-
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rectly on spandrels is plotted along an invisible line that extends from the cen-
troid of the spandrel section at the left end of the spandrel to the centroid of the 
spandrel section at the top of the spandrel. 

The onscreen graphical display can be sent to printer using any of the follow-
ing commands. Use the File menu > Print Graphics command to print the ac-
tive window. To capture the graphical display in a file for printing through an-
other application, use the File menu > Capture Enhanced Metafile command 
to create an .emf file, or use the File menu > Capture Picture command to 
create a bitmap (.bmp) file. Create a screen capture of the active window using 
the Alt+ Print Screen keyboard keys or create a screen capture of the entire 
window using the Ctrl + Print Screen keyboard keys. Then use the Ctrl+V 
keyboard keys to paste the saved image into Paint or other graphical program.  

4.2 Tabular Display of Design Information 
In addition to model definition and analysis results, the design information for 
all piers and spandrels or for only selected piers and spandrels can be displayed 
in tabular spreadsheet format. Currently, the program generates design pier lo-
cation data, pier basic overwrite data, uniform reinforcing sections, general re-
inforcing sections, simplified T and C sections, spandrel location data, spandrel 
basic overwrite data, and spandrel geometry data. The tabular spreadsheet out-
put can be displayed by selecting the Display menu > Show Tables command 
to access the Choose Tables for Display form. That form can be used to 
choose which tables or sets of tables are to be displayed.  

The names of the tables are displayed in a tree structure, which can be col-
lapsed or expanded by clicking on an item in the tree. Click on the small check 
boxes preceding the items to select those tables for display. If a branch of the 
tree is selected, all of the tables under that branch are selected. The selected set 
of tables can be saved as a Named Set using the Save Named Set button. This 
named set can be used in the future for quick selection. If one or more frame 
members are selected on the structural model before accessing the Choose Ta-
bles for Display form, the Selection Only check box will be checked when the 
form displays and, the program will display information for the selected mem-
bers only; uncheck the check box to display information for all applicable "un-
selected" members in the model. If the Show Unformatted check box is 
checked, the numbers will be displayed unformatted, instead of being dis-
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played using a limited number of decimal digits. The unformatted option pro-
vides higher precision output that can then be copied into other programs.  

Use the other buttons in the form to tailor the data display. For example, click 
the Select Load Cases button to specify which load cases are to be included in 
the display of model definition data; click the Select Analysis Case and Modi-
fy/Show Options to specify which analysis cases are to be included and how 
analysis results are displayed.  

After selecting all of the tables for shear wall design and the display options, 
click the OK button to display a form showing one of the selected design ta-
bles, with a drop-down list in the upper right-hand corner of the form that can 
be used to select other tables for display.  

Use the scroll bars on the bottom and right side of the tables to scroll right and 
left or up and down if portions of the data table can not be displayed in the 
form's display area. The columns can be resized by clicking the left mouse but-
ton on the separator of the headers, holding down the left mouse button and 
then dragging the mouse to the left or right. Reset the column widths to their 
default values by selecting the Format-Filter-Sort menu > Reset Default 
Column Widths command on the form. The table can be split into two or 
more tables by clicking on the small black rectangular area near the bottom-left 
corner of the table, holding down the left mouse button, and then dragging the 
mouse button to the left or right. Repeat this process to add more splits. Use the 
split and horizontal scroll bar to put two columns side by side for easier com-
parison. The splits can be removed by selecting the Format-Filter-Sort menu 
> Remove Splits command on the form. Alternatively, remove the split by 
clicking, holding and dragging the left mouse button to merge the split key to 
its original location.  

Select multiple consecutive columns by putting the cursor on the header, hold-
ing down the mouse button, and then dragging the mouse button left or right. 
Alternatively, depress the Shift key and click the left mouse button to select a 
range of columns.  

Each of the individual fields (columns) can be formatted. Fields with text in-
formation can be set for specific types of alignment (center, left, right) and to 
specific widths. In addition to setting the alignment and column widths, fields 
with numeric data can be set for the maximum number of characters, zero tol-
erance, number of decimal digits and so forth. The tables can be formatted, fil-
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tered and sorted using multiple criteria accessed using the Format-Filter-Sort 
menu on the form. Filtering and sorting features can be useful in identifying 
critical cases. After specifying the table formatting information, save it to a 
format file that can be used in the future by selecting the appropriate feature 
available under the Format-Filter-Sort menu. 

The current table (i.e., the table in the active window) can be exported to Ex-
cel, Access, .rtf., .html, and plain text formats. In both Excel spreadsheet and 
Access database formats, the tables can have many columns, making the tables 
very wide. In .rft and .html formats, the tables are split at convenient points to 
make a reasonably printable document. In plain text format, the tables can be 
saved with or without the splits. To export a table to Excel, for example, select 
the File menu > Export Current Table > To Excel command. The program 
will export the entire table to an Excel spreadsheet workbook and will automat-
ically open the file in MS Excel. Similarly, if the table is exported to other 
formats, the default editor specific to that format will open the document, pro-
vided that the editor is available in the computer. The table will be saved in 
that format only if the relevant editor is not available. Instead of exporting or 
displaying the currently displayed table, the entire set of available tables can be 
exported and displayed in the afore-mentioned formats by selecting the File 
menu and the appropriate submenu command. With these exporting and dis-
play features, the tables can be saved in many required formats and can be 
printed. Many other features of the design tables are left for the user to discov-
er by using the program. 

4.3 Detailed Display of Member Specific Information 
Interactive design is a powerful mode that allows quick, on-screen review of 
design results for a specific pier or spandrel. This mode allows easy modifica-
tion to design parameters (overwrites) and immediate review of the new re-
sults. 

Note that a design must have been run for the interactive design mode to be 
available. To run a design, click the Design menu > Shear Wall Design > 
Start Design/Check of Structure command. 

To enter the interactive design and review mode, right click on a wall pier or 
spandrel while the design results are displayed. If design results are not cur-
rently displayed (and the design has been run), click the Design menu > Shear 
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Wall Design > Interactive Wall Design command and then right click a pier 
or spandrel to enter the interactive design and review mode for that pier or 
spandrel. 

Note that if both a pier and a spandrel label are assigned to the right-clicked 
object, a pop-up box offers the choice to enter the interactive design and re-
view mode for the pier or for the spandrel. Appendix E provides additional in-
formation about interactive shear wall design. 

4.4 Output of Design Information 
In addition to model definition and analysis results, the design information for 
all piers and spandrels or for selected piers and spandrels only can be saved in 
tabular format. For ACI 318-14 code, the program saves simplified pier longi-
tudinal reinforcing, simplified pier edge members, Section Designer pier rein-
forcing ratios, section Designer pier D/C ratios, spandrel longitudinal reinforc-
ing, shear reinforcing, pier demand/capacity ratios and pier boundary zones.  
Save the file output by selecting the File menu > Print Tables command to 
access the Choose Tables for Printing form. Use the options on the form to 
choose which table or set of tables to save in a file or print. This form is very 
similar to the Choose Tables for Display form, which has been described earli-
er in this chapter in the "Tabular Display of Design Information" section. 

The name of the tables are displayed in a tree structure, which can be collapsed 
or expanded by clicking on an item in the tree. Click on the small check boxes 
preceding the items to select those tables for printing or saving to a file. If a 
branch of the tree is selected, all of the tables under that branch are selected.  
When all options for printing or saving the data to file have been specified, the 
settings can be saved as a Named Set using the Save Named Set button. The 
Named Set can be easily recalled in the future, reducing the need to reselect the 
options and ensuring that output is consistent from one printing effort to anoth-
er. 

If one or more structural members are selected before the Choose Tables for 
Printing form is accessed, the Selection Only check box will be checked, and 
the program will save or print the data for the selected members only; uncheck 
the check box to save or print the data for all appropriate "unselected" mem-
bers. 
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The output can be generated in a variety of formats, including rich text format 
(.rft), plain text with and without splits or page breaks (.txt), and hyperlink text 
markup language (.htm) by choosing the appropriate option on the right side of 
the form.  

Printed output can be specified to have a landscaped orientation, in which the 
width of the resulting printout on a given page is longer than the height of the 
printout.  

Filtering criteria can be applied if those criteria were specified using the For-
mat-Filter-Sort menu > Format Table command when the selected data ta-
bles were displayed using the Display menu > Show Tables command. The 
output also can be specified to include a hyperlinked contents to facilitate ac-
cessing specific areas of the printout. 

There are other buttons on the form that do not affect saving or printing design 
information. For example, the Select Load Cases button affects only sav-
ing/printing model definition data. The Select Analysis Cases and Modi-
fy/Show Options buttons affect only saving/printing analysis results. 

After clicking all the necessary tables for steel frame design and all necessary 
options, clicking the OK button will save/print the design tables. 

Although the File name > Print Tables command path is dedicated for sav-
ing/printing design information, it is not the only path to do so. Design tables 
can be saved in different formats using the path Display menu > Show Tables 
command. 

4.5 Error Messages and Warnings 
Error messages and warnings may be displayed in the shear wall design output. 
The messages are self-explanatory. 
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Appendix A 
Shear Wall Design Preferences 

The shear wall design preferences are basic properties that apply to all wall pier 
and spandrel elements. Table A-1 identifies shear wall design preferences for 
ACI 318-14. Default values are provided for all shear wall design preference 
items. Thus, it is not required that preferences be specified. However, at least 
review the default values for the preference items to make sure they are 
acceptable. Refer to the program Help for an explanation of how to change a 
preference. 

Table A-1  Shear Wall Preferences 
 

Item 
Possible 
Values 

Default 
Value 

 
Description 

Design Code Any code in the 
program 

 Design code used for design of concrete 
shear wall elements (wall piers and 
spandrels) 

Phi (Tension 
Controlled) 

> 0 0.9 The strength reduction factor for bending in 
a wall pier or spandrel in tension controlled 
section. 

Phi 
(Compression 

Controlled) 

> 0 0.65 The strength reduction factor for axial 
compression in a wall pier. 

Phi (Shear 
and/or Torsion) 

> 0 0.75 The strength reduction factor for shear in a 
wall pier or spandrel for a nonseismic 
condition. 
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Item 
Possible 
Values 

Default 
Value 

 
Description 

Phi (Shear 
Seismic) 

> 0 0.6 The strength reduction factor for shear in a 
wall pier or spandrel for a seismic condition. 

Pmax Factor > 0 0.8 A factor used to reduce the allowable 
maximum compressive design strength. 

Number of 
Curves 

≥ 4 24 Number of equally spaced interaction 
curves used to create a full 360-degree 
interaction surface (this item should be a 
multiple of four). We recommend that you 
use 24 for this item.  

Number of 
Points 

≥ 11 11 Number of points used for defining a single 
curve in a wall pier interaction surface (this 
item should be odd). 

Edge Design 
PT-max 

> 0 0.06 Maximum ratio of tension reinforcing 
allowed in edge members, PTmax.  

Edge Design 
PC-max 

> 0 0.04 Maximum ratio of compression reinforcing 
allowed in edge members, PCmax.  

Section Design 
IP-Max 

≥ Section  
Design IP-Min 

0.02 The maximum ratio of reinforcing 
considered in the design of a pier with a 
Section Designer section. 

Section Design 
IP-Min 

> 0 0.0025 The minimum ratio of reinforcing considered 
in the design of a pier with a Section 
Designer section. 

Utilization Factor 
Limit 

> 0 0.95 Stress ratios that are less than or equal to 
this value are considered acceptable.   
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Design Overwrites 

The shear wall design overwrites are basic assignments that apply only to those 
piers or spandrels to which they are assigned. The overwrites for piers and 
spandrels are separate. Tables B-1 and B-2 identify the shear wall overwrites 
for piers and spandrels, respectively, for ACI 318-14. Note that the available 
overwrites change depending on the pier section type (Uniform Reinforcing, 
General Reinforcing, or Simplified T and C).   

Default values are provided for all pier and spandrel overwrite items. Thus, it is 
not necessary to specify or change any of the overwrites. However, at least 
review the default values for the overwrite items to make sure they are accept-
able. When changes are made to overwrite items, the program applies the 
changes only to the elements to which they are specifically assigned; that is, to 
the elements that are selected when the overwrites are changed. Refer to the 
program Help for an explanation of how to change the overwrites. 

Table B-1: Pier Design Overwrites 

Pier Overwrite 
Item 

Possible 
Values 

Default 
Value 

 
Pier Overwrite Description 

Design this Pier Yes or No Yes Toggle for design of the pier when the 
Design menu > Shear Wall Design > Start 
Design/Check command is clicked. 
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Pier Overwrite 
Item 

Possible 
Values 

Default 
Value 

 
Pier Overwrite Description 

LL Reduction 
Factor 

Program  
calculated,  

> 0 

Program  
calculated 

A reducible live load is multiplied by this 
factor to obtain the reduced live load. 
Entering 0 for this item means that it is 
program calculated. See the subsection 
entitled "LL Reduction Factor" for more 
information. 

Design is 
Special Seismic 

Yes or No Yes Toggle for design as seismic or nonseismic. 
Additional design checks are performed for 
seismic elements compared to nonseismic 
elements. Also, in some cases, the strength 
reduction factors are different. 

Pier Section 
Type 

Uniform  
Reinforcing,  

General  
Reinforcing,  
Simplified  
T and C 

Uniform 
Reinforcing 

This item indicates the type of pier. The 
General Reinforcing option is not available 
unless General pier sections have 
previously been defined in Section 
Designer.  

Overwrites Applicable to Uniform Reinforcing Pier Sections  
Edge Bar Name Any defined bar 

size 
Varies The size of the uniformly spaced edge bars. 

Edge Bar 
Spacing 

>0 12" The spacing of the uniformly spaced edge 
bars. 

End/Corner Bar 
Name 

Any defined bar 
size 

Varies The size of end and corner bars. 

Clear Cover >0 1.5" The clear cover for the edge, end and 
corners bars. 

Material Any defined 
concrete 

material property 

Varies The material property associated with the 
pier. 

Check/Design 
Reinforcing 

Check or  
Design 

Design This item indicate whether the pier section 
is to be designed or checked. 

Overwrites Applicable to General Reinforcing Pier Sections  
Section Bottom Any general pier 

section defined 
in Section 
Designer 

The first pier in 
the list of 
Section 

Designer piers 

Name of a pier section, defined in Section 
Designer that is assigned to the bottom of 
the pier.  
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Table B-1: Pier Design Overwrites 

Pier Overwrite 
Item 

Possible 
Values 

Default 
Value 

 
Pier Overwrite Description 

Section Top Any general pier 
section defined 

in  
Section  

Designer 

The first pier in 
the list of  
Section  

Designer piers 

Name of a pier section, defined in Section 
Designer, that is assigned to the top of the 
pier.  

Check/Design 
Reinforcing 

Check or  
Design 

Design This item indicates whether the pier section 
is to be designed or checked. 

Overwrites Applicable to Simplified T and C Pier Sections  

ThickBot Program  
calculated,  

or > 0 

Program  
calculated 

Wall pier thickness at bottom of pier, tp. 
Inputting 0 means the item is to be program 
calculated. 

LengthBot Program  
calculated,  

or > 0 

Program  
calculated 

Wall pier length at bottom of pier, Lp. 
Inputting 0 means the item is to be program 
calculated. 

DB1LeftBot ≥ 0 0 Length of the bottom of a user-defined edge 
member on the left side of a wall pier, 
DB1left.  

DB2LeftBot ≥ 0 0 Width of the bottom of a user-defined edge 
member on the left side of a wall pier, 
DB2left. See Figure 1 in Shear Wall Design 
Technical Note 6 Wall Pier Design Section. 
See the subsection entitled "User-Defined 
Edge Members" for more information. 

DB1RightBot ≥ 0 Same as 
DB1-left-bot 

Length of the bottom of a user-defined edge 
member on the right side of a wall pier, 
DB1right.  

DB2RightBot ≥ 0 Same as 
DB2-left-bot 

Width of the bottom of a user-defined edge 
member on the right side of a wall pier, 
DB2right.  

ThickTop Program  
calculated,  

or > 0 

Program  
calculated 

Wall pier thickness at top of pier,  
tp. Inputting 0 means the item is to be 
program calculated. 

LengthTop Program  
calculated,  

or > 0 

Program  
calculated 

Wall pier length at top of pier, Lp. Inputting 0 
means the item is to be program calculated. 

DB1LeftTop ≥ 0 0 Length of the top of a user-defined edge 
member on the left side of a wall pier, 
DB1left.  

DB2LeftTop ≥ 0 0 Width of the top of a user-defined edge 
member on the left side of a wall pier, 
DB2left.  
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Pier Overwrite 
Item 

Possible 
Values 

Default 
Value 

 
Pier Overwrite Description 

DB1RightTop ≥ 0 Same as 
DB1-left-bot 

Length of the top of a user-defined edge 
member on the right side of a wall pier, 
DB1right.  

DB2RightTop ≥ 0 Same as 
DB2-left-bot 

Width of the top of a user-defined edge 
member on the right side of a wall pier, 
DB2right.  

Material Any defined  
concrete  
material  
property 

See "Material 
Properties" in 
Shear Wall 

Design 
Technical Note 6 
Wall Pier Design 

Section   

Material property associated with the pier.  

Edge Design  
PC-max 

> 0 Specified in  
Preferences 

Maximum ratio of compression  
reinforcing allowed in edge members, 
PCmax.  

Edge Design  
PT-max 

> 0 Specified in  
Preferences 

Maximum ratio of tension reinforcing 
allowed in edge members, PTmax.  

 

Table B-2 Spandrel Design Overwrites 

Spandrel 
Overwrite Item 

Possible 
Values 

Default 
Value 

 
Spandrel Overwrite Description 

Design this 
Spandrel 

Yes or No Yes Toggle for design of the spandrel when the 
Design menu > Shear Wall Design > Start 
Design/Check command is clicked. 

LL Reduction 
Factor 

Program  
calculated,  

> 0 

Program  
calculated 

A reducible live load is multiplied by this 
factor to obtain the reduced live load. 
Entering 0 for this item means that it is 
program calculated. See the subsection 
entitled "LL Reduction Factor" later in this 
Appendix for more information. 

Design is  
Special Seismic 

Yes or No Yes Toggle for design as seismic or nonseismic. 
Additional design checks are performed for 
seismic elements compared to nonseismic 
elements. Also, in some cases the strength 
reduction factors are different. 

Length Program  
calculated,  

or > 0 

Program  
calculated 

Wall spandrel length, Ls. Inputting 0 means 
the item is to be program calculated. 
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Table B-2 Spandrel Design Overwrites 

Spandrel 
Overwrite Item 

Possible 
Values 

Default 
Value 

 
Spandrel Overwrite Description 

ThickLeft Program  
calculated,  

or > 0 

Program  
calculated 

Wall spandrel thickness at left side of 
spandrel, ts. Inputting 0 means the item is to 
be program calculated. 

DepthLeft Program  
calculated,  

or > 0 

Program  
calculated 

Wall spandrel depth at left side of spandrel, 
hs. Inputting 0 means the item is to be 
program calculated. 

CoverBotLeft Program  
calculated,  

or > 0 

Program  
calculated 

Distance from bottom of spandrel to 
centroid of bottom reinforcing, dr-bot left on left 
side of beam. Inputting 0 means the item is 
to be program calculated as 0.1hs. 

CoverTopLeft Program  
calculated,  

or > 0 

Program  
calculated 

Distance from top of spandrel to centroid of 
top reinforcing, dr-top left on left side of beam. 
Inputting 0 means the item is to be program 
calculated as 0.1hs. 

SlabWidthLeft ≥ 0 0 Slab width for T-beam at left end of 
spandrel, bs.  

SlabDepthLeft ≥ 0 0 Slab depth for T-beam at left end of 
spandrel, ds. 

ThickRight Program  
calculated,  

or > 0 

Program  
calculated 

Wall spandrel thickness at right side of 
spandrel, ts. Inputting 0 means the item is to 
be program calculated. 

DepthRight Program  
calculated,  

or > 0 

Program  
calculated 

Wall spandrel depth at right side of 
spandrel, hs. Inputting 0 means the item is 
to be program calculated. 

CoverBotRight Program  
calculated,  

or > 0 

Program  
calculated 

Distance from bottom of spandrel to 
centroid of bottom reinforcing, dr-bot right on 
right side of beam. Inputting 0 means the 
item is to be program calculated as 0.1hs. 

Cover- 
TopRight 

Program  
calculated,  

or > 0 

Program  
calculated 

Distance from top of spandrel to centroid of 
top reinforcing, dr-top right on right side of 
beam. Inputting 0 means the item is to be 
program calculated as 0.1hs. 

SlabWidthRight ≥ 0 0 Slab width for T-beam at right end of 
spandrel, bs.  

SlabDepthRight ≥ 0 0 Slab depth for T-beam at right end of 
spandrel, ds.  
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Table B-2 Spandrel Design Overwrites 

Spandrel 
Overwrite Item 

Possible 
Values 

Default 
Value 

 
Spandrel Overwrite Description 

Material Any defined  
concrete 
material  
property 

See "Default 
Design Material  

Property" in Shear 
Wall Design 

Technical Note 7 
Wall Spandrel 

Design Sections  

Material property associated with the 
spandrel. 

Consider Vc Yes or No Yes Toggle switch to consider Vc (concrete 
shear capacity) when computing the 
shear capacity of the spandrel. 

 

B.1 LL Reduction Factor 
If the LL Reduction Factor is program calculated, it is based on the live load 
reduction method chosen in the live load reduction preferences. If you specify 
your own LL Reduction Factor, the program ignores any reduction method 
specified in the live load reduction preferences and simply calculates the 
reduced live load for a pier or spandrel by multiplying the specified LL 
Reduction Factor times the reducible live load. 

Important Note: The LL reduction factor is not applied to any load 
combination that is included in a design load combination (combo or combos). 
For example, assume you have two static load cases labeled DL and RLL. DL 
is a dead load and RLL is a reducible live load. Now assume that you create a 
design load combination named DESCOMB1 that includes DL and RLL. Then 
for design load combination DESCOMB1, the RLL load is multiplied by the 
LL reduction factor. Next assume that you create a load combination called 
COMB2 that includes RLL. Now assume that you create a design load 
combination called DESCOMB3 that included DL and COMB2. For design 
load combination DESCOMB3, the RLL load that is part of COMB2 is not 
multiplied by the LL reduction factor. 

B.2 User-Defined Edge Members 
When defining a user-defined edge member, you must specify both a nonzero 
value for DB1 and a nonzero value for DB2. If either DB1 or DB2 is specified 
as zero, the edge member width is taken as the same as the pier thickness and 
the edge member length is determined by the program. 
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Appendix C  
Analysis Sections and Design Sections 

It is important to understand the difference between analysis sections and 
design sections when performing shear wall design. Analysis sections are 
simply the objects defined in your model that make up the pier or spandrel 
section. The analysis section for wall piers is the assemblage of wall and 
column sections that make up the pier. Similarly, the analysis section for 
spandrels is the assemblage of wall and beam sections that make up the 
spandrel. The analysis is based on these section properties, and thus, the design 
forces are based on these analysis section properties. 

The design section is completely separate from the analysis section. Three 
types of pier design sections are available. They are: 

 Uniform Reinforcing Section: For flexural designs and/or checks, the 
program automatically (and internally) creates a Section Designer pier 
section of the same shape as the analysis section pier. Uniform reinforcing 
is placed in this pier. The reinforcing can be modified in the pier 
overwrites. The Uniform Reinforcing Section pier may be planar or it may 
be three-dimensional. 

For shear design and boundary zone checks, the program automatically 
(and internally) breaks the analysis section pier up into planar legs and then 
performs the design on each leg separately and reports the results 
separately for each leg. Note that the planar legs are derived from the area 
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objects defined in the model, not from the pier section defined in Section 
Designer. The pier section defined in Section Designer is only used for the 
flexural design/check. 

 General Reinforcing Section: For flexural designs and/or checks, the pier 
geometry and the reinforcing are defined by the user in the Section 
Designer utility. The pier defined in Section Designer may be planar or it 
may be three-dimensional. 

For shear design and boundary zone checks, the program automatically 
(and internally) breaks the analysis section pier into planar legs and then 
performs the design on each leg separately and reports the results 
separately for each leg. Note that the planar legs are derived from the area 
objects defined in the model, not from the pier section defined in Section 
Designer. The pier section defined in Section Designer is only used for the 
flexural design/check. 

 Simplified Pier Section: This pier section is defined in the pier design 
overwrites. The simplified section is defined by a length and a thickness. 
The length is in the pier 2-axis direction and the thickness is in the pier 3-
axis direction.  

In addition, you can, if desired, specify thickened edge members at one or 
both ends of the simplified pier section. You cannot specify reinforcing in 
a simplified section. Thus, the simplified section can only be used for 
design, not for checking user-specified sections. Simplified sections are 
always planar. 

Only one type of spandrel design section is available. It is defined in the 
spandrel design overwrites. A typical spandrel is defined by a depth, 
thickness and length. The depth is in the spandrel  2-axis  direction; the  
thickness  is in the  spandrel  3-axis direction; and the length is in the 
spandrel 1-axis direction. Spandrel sections are always planar. 

In addition, you can, if desired, specify a slab thickness and depth, making 
the spandrel design section into a T-beam. You cannot specify reinforcing 
in a spandrel section. Thus, you can only design spandrel sections, not 
check them. 
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 Appendix D Analysis Section and Design Sections 
 

The pier and spandrel design sections are designed for the forces obtained 
from the program's analysis, which is based on the analysis sections. In other 
words, the design sections are designed based on the forces obtained for the 
analysis sections. 
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